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i-Tree is a cooperative initiative

About i-Tree
i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service
that provides urban and community forestry analysis and benefits assessment tools. The
i-Tree tools help communities of all sizes to strengthen their urban forest management
and advocacy efforts by quantifying the environmental services that trees provide and
assessing the structure of the urban forest.
i-Tree has been used by communities, non-profit organizations, consultants, volunteers,
and students to report on the urban forest at all scales from individual trees to parcels,
neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem
services that trees provide, i-Tree users can link urban forest management activities with
environmental quality and community livability. Whether your interest is a single tree or an
entire forest, i-Tree provides baseline data that you can use to demonstrate value and set
priorities for more effective decision-making.
Developed by USDA Forest Service and numerous cooperators, i-Tree is in the public
domain and available by request through the i-Tree website (www.itreetools.org). The Forest
Service, Davey Tree Expert Company, the Arbor Day Foundation, Society of Municipal
Arborists, the International Society of Arboriculture, and Casey Trees have entered into a
cooperative partnership to further develop, disseminate, and provide technical support for
the suite.

i-Tree Products
The i-Tree software suite v 4.0 includes the following urban forest analysis tools and utility
programs.
i-Tree Eco provides a broad picture of the entire urban forest. It is designed to use field
data from randomly located plots throughout a community along with local hourly air
pollution and meteorological data to quantify urban forest structure, environmental effects,
and value to communities.
i-Tree Streets focuses on the ecosystem services and structure of a municipality’s street
tree population. It makes use of a sample or complete inventory to quantify and put a
dollar value on the trees’ annual environmental and aesthetic benefits, including energy
conservation, air quality improvement, carbon dioxide reduction, stormwater control, and
property value increases.
i-Tree Hydro (Beta) is the first vegetation-specific urban hydrology model. It is designed
to model the effects of changes in urban tree cover and impervious surfaces on hourly
stream flows and water quality at the watershed level.

i-Tree Vue allows you to make use of freely available national land cover data maps to
assess your community’s land cover, including tree canopy, and some of the ecosystem
services provided by your current urban forest. The effects of planting scenarios on future
benefits can also be modeled.
i-Tree Species Selector is a free-standing utility designed to help urban foresters select
the most appropriate tree species based on environmental function and geographic area.
i-Tree Storm helps you to assess widespread community damage in a simple, credible,
and efficient manner immediately after a severe storm. It is adaptable to various
community types and sizes and provides information on the time and funds needed to
mitigate storm damage.
i-Tree Design (beta) is a simple online tool that provides a platform for assessments
of individual trees at the parcel level. This tool links to Google Maps and allows you to
see how tree selection, tree size, and placement around your home effects energy use
and other benefits. This beta tool is the first stage in development of more sophisticated
options that will be available in future versions.
i-Tree Canopy offers a quick and easy way to produce a statistically valid estimate of land
cover types (e.g., tree cover) using aerial images available in Google Maps. The data can
be used by urban forest managers to estimate tree canopy cover, set canopy goals, and
track success; and to estimate inputs for use in i-Tree Hydro and elsewhere where land
cover data are needed.
All beta programs are still in development, therefore feedback is particularly appreciated.

Disclaimer
The use of trade, firm, or corporation names in this publication is solely for the information
and convenience of the reader. Such use does not constitute an official endorsement or
approval by the U.S. Department of Agriculture or the Forest Service of any product or
service to the exclusion of others that may be suitable. The software distributed under the
label “i-Tree Software Suite v. 4.0” is provided without warranty of any kind. Its use is
governed by the End User License Agreement (EULA) to which the user agrees before
installation.

Feedback
The i-Tree Development Team actively seeks feedback on any component of the project:
the software suite itself, the manuals, or the process of development, dissemination,
support, and refinement. Please send comments through any of the means listed on the
i-Tree support page: http://www.itreetools.org/support/.

Acknowledgments
i-Tree
Components of the i-Tree software suite have been developed over the last few decades
by the USDA Forest Service and numerous cooperators. Support for the development and
release of i-Tree v. 4.0 has come from USDA Forest Service Research, State and Private
Forestry, and their cooperators through the i-Tree Cooperative Partnership of Davey
Tree Expert Company, the Arbor Day Foundation, Society of Municipal Arborists, the
International Society of Arboriculture, and Casey Trees.

i-Tree Vue
i-Tree Vue was conceived and developed by Alexis Ellis (USDA Forest Service Northern
Research Station), Mike Binkley (the Davey Institute), and David J. Nowak (USDA Forest
Service Northern Research Station). The manual was edited and designed by Kelaine
Vargas.

Table of Contents
Introduction
About This Manual

Installation

1
2

3

System Requirements

3

Installation

3

Exploring Vue With the Sample Project

3

Phase I: Getting Started
MRLC Consortium Viewer
Clip NLCD data using ArcGIS (for advanced users)

Phase II: Working With Vue

4
4
5

6

Clipping an Area of Interest (optional)

7

Understanding the Vue Layout

8

Main windows

8

Map controls

8

GoogleFind

8

GoogleVue

8

Tabs panel

9

Analysis Options

9

NLCD tree and impervious cover adjustment analysis options 

10

Ecosystem services

10

Existing urban forest structure reports

11

Tree canopy % change reports 

11

Printing and saving results

12

Appendix: Limitation and Data Notes
Limitations

13
13

Generalized estimates

13

NLCD tree cover estimates

13

Air pollution removal estimates

13

Carbon storage and sequestration estimates 

14

Dollar value estimates

14

NLCD Imagery Technical Notes
Projection system 

14
15

Air Pollution Removal Methods

15

References

16

Introduction
i-Tree Vue is a free-standing utility still in development. It allows you to make use of freely
available national land cover data maps to assess your community’s tree canopy cover
and some of the ecosystem services provided by the urban forest. The effects of different
planting scenarios on future benefits can also be modeled.
New functionality allows you to make adjustments to canopy and impervious estimates
based on recent research. In addition, a clipping tool allows you to refine simple boundaries
of National Land Cover Data (NLCD) images within the Vue application. Interactivity with
Google Maps allows improved NLCD image interpretation and sets the platform for future
Vue enhancements.
The best way to gain an understanding of your community’s urban forest and to lay the
foundations for good stewardship is to gather real data in the field, including tree species,
size, and health; i-Tree Eco and i-Tree Streets are the i-Tree components to help you do
that. Sometimes, however, a broad estimate of canopy and tree-related benefits is helpful,
either as a first step towards a greater understanding or because time and financial
resources are limited. Vue was designed for just this situation.
i-Tree Vue offers the following advantages:
It provides a broad estimate of tree canopy, air pollution removal, carbon storage and
annual carbon sequestration for the contiguous United States.
It allows you to explore National Land Cover Data information and provides a broad
estimate of land cover classes.
No field data are required.
Canopy cover and ecosystem services are presented in spatial terms, so you can
visualize how they vary across your community.
The effects of different planting scenarios on the future urban forest can be visualized.
GIS-ready datasets can be created, but no GIS software or skills are needed.
User friendly tools within the Vue application allow you to refine an area of interest for
analysis.
Integration of regional correction factors allow you to adjust and improve upon NLCD
estimates based on recent research.
Vue does have several limitations, however, that should be kept in mind. These are related
to the data source (2001 land cover maps derived from 30-meter resolution satellite
imagery) and the use of state and national averages for air pollution removal and carbon
sequestration. These limitations are discussed in more detail in the Appendix.
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About This Manual
This manual provides all the information needed to conduct a Vue project. We start with
installing the software and move on to the two project phases:
Phase I: Getting started. In this section, we describe how to gather the free National
Land Cover Data maps that are necessary to run Vue.
Phase II: Working with Vue. In this section, we run the Vue software and explore the
ecosystem services and canopy cover of our present and future urban forest.
Appendix: The appendix provides a detailed description of the limitations of i-Tree Vue,
some technical notes, and information on how the underlying data were derived.
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Installation
System Requirements
Minimum hardware:
• Pentium or compatible 1600 Mhz or faster processor
• Memory/RAM: 1 GB minimum; 2GB or higher recommended
• Display properties: 24-bit color depth
• Screen resolution: 1024 x 768 or higher at normal size (96 dpi)
• Hard drive with at least 500 MB free space
Software:
• Windows XP service pack 3 or higher OS
• Web browser: Internet Explorer 7 or higher
• Adobe PDF Reader 9.0

Installation
To install Vue:

1 Visit www.itreetools.org to download the software or insert the i-Tree Installation
CD into your CD-ROM drive.

2 Follow the on-screen instructions to run the itree_setup.exe file. This may take
several minutes depending on which files need to be installed.

3 Follow the Installation Wizard instructions to complete the installation (default
location recommended).

Exploring Vue With the Sample Project
If you would like to begin exploring Vue’s capabilities, you can skip to Phase II: Working
with Vue and use the sample projects that are included. Otherwise, move on to Phase I to
gather the NLCD maps you’ll need to analyze your own urban forest.
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Phase I: Getting Started
You’ll need to procure three images for your study area from the National Land Cover
Datasets (NLCD): land cover, percent impervious cover, and percent tree canopy.

MRLC Consortium Viewer
The MRLC Consortium Viewer is the gateway to obtaining the necessary images. To get
started, turn off any pop-up blockers on your web browser, go to http://gisdata.usgs.net/
website/MRLC/ and review the user instructions.

1 Click Launch MRLC Consortium Viewer to begin.
2 Use the Zoom tool to focus the window tightly on your study area.
3 You can use the categories under Display, such as Places, Transportation,

Boundaries, and Hydrography, to help you clarify your boundaries. Click the green
arrow to the left of the category to view the options and then check the boxes to
show the information on the map.

4 Once you have focused on your study area, click the Download tab on the right,
click the arrow next to Land Cover and select only these layers:
NLCD 2001 Land Cover
NLCD 2001 Canopy (Tree Cover)
NLCD 2001 Impervious Surface

5 Use the rectangular Download tool from the toolbar group on the left to draw a box
around the final download area on the map. Note: Do not drag the tool beyond the
map edges as this causes a reset of the viewer.

6 A pop-up window appears. Make sure that all three datasets are present in the

download window because the three images must be downloaded at the same
time with the exact same extents. For each layer, click Download and the Save
File window will appear. (Depending on server demand, the wait between these
two steps can be VERY long, even hours.) Click Save and navigate to the location
where you want the folder stored and change the default name to Land_cover,
Canopy, or Impervious_Surface as appropriate.

7 Unzip each folder into your preferred location. Make a note of where the folders
are stored; you’ll need this for Phase II. Each folder includes a metadata file (in
.html format) that provides all of the background information on the data.
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Clip NLCD data using ArcGIS (for advanced users)
If you have access to ArcGIS with Spatial Analyst extension, you can use it to “clip” the
NLCD images to include only your study area. For users without access to GIS, a simple
clipping option is available within Vue v. 4 that will allow you to change the boundaries of
the base NLCD imagery to focus on your area of interest.

1 Open ArcMap and make sure Spatial Analyst is available:
a In the main toolbar, choose Tools > Extensions > Spatial Analyst.
b Open the ArcToolBox panel using the ArcToolBox button under the main
menu.

2 Extract the area for each of the three NLCD images:
a ArcToolBox > Spatial Analysis Tools > Extraction > Extract by mask
(with area of interest polygon as the mask).

3 Export the extracted data:
a Right-click layer name > Data > Export Data.
b Change location for the exported data (remembering to only single click on
the output folder location).

c Change format to TIFF.
d Adjust name as needed.
e Leave other options at defaults.
4 Create a World File (*.TFW) for each of the three NLCD images:
a ArcToolBox > Data Management Tools > Raster > Raster Properties >
Export Raster World File.
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Phase II: Working With Vue
To begin working with Vue:

1 Click your computer’s Start menu > (All) Programs > i-Tree > Vue.
2 The Browse for NLCD Imagery window will appear.
a If you have gathered your own images using the steps in Phase I, click the
Browse button for land cover, tree canopy, and impervious cover images
and navigate to the locations where you saved each file.

b If you want to explore using a sample project, the image files are located in

the folder where you installed Vue, most likely C:\Program Files\i-Tree\Vue\
in folders with names beginning SAMPLE_.

3 Once all three images have been loaded, select the correct state from the

drop-down menu at the bottom. This will load default pollution removal values
associated with trees for your state.
Note: If your community has conducted an i-Tree Eco project, you can use the
results of that project instead of the defaults. To do so, select i-Tree Eco project
from the drop-down list. In the window that opens navigate to the place where you
saved your project and click Open.

4 If you want to define a specific area of interest on unclipped NLCD imagery, check
the box next to that option. Keep in mind that this option is only for unclipped
imagery; if you used GIS previously to clip your image, you can not use this
function within Vue.

5 Click OK.
6 If you chose to define an area of interest, a new window will open for editing. If you
chose not to define an area of interest, image processing will begin.

Usage note: Output processing time is system and project dependent. A message will
appear on the Vue welcome screen asking you to please wait while image statistics
are calculated. On slower machines, processing may take several minutes.
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Clipping an Area of Interest (optional)
If you chose to define a specific area of interest in the imagery in the steps above, the
Define AOI on NLCD Imagery window will open. Your NLCD downloaded imagery is on the
right and a Google map with your image outlined in red is on the left. In this step you will
draw an outline of your area of interest on the Google map and then transfer that outline to
the NLCD imagery, refine the edges, and then “clip” and save the new NLCD images.

1 The first step is to draw an outline around your area of interest on the Google map.

The standard Google maps tools are available, including zoom, pan, and the option
to view the map as a standard map, and in satellite, hybrid, and terrain views. To
begin:

a To begin defining your area of interest, first select the Define AOI tool

.

b Then draw an outline around your area of interest by single-clicking around
the edges. You can zoom and pan during this stage as necessary.

Note: Draw your boundary outlines well outside of your area of interest to
accommodate the fact that the imagery is composed of 30 m pixels.

c You can use the Delete Last Point tool

to undo your work stepwise.

d When you are satisfied with your outline, be sure you have closed the
polygon, and click the Finish AOI button

e You can use the Cancel AOI button
and start over.

.

to remove the outline completely

2 Once you are satisfied with the outline, transfer it to the NLCD image by clicking

the Draw AOI on NLCD button. Note that the window with the NLCD images is
governed by a slightly different set of tools. Here the magnifying glass tools are for
zooming, the hand is for panning, the globe zooms all the way out, and the button
on the far right
toggles among the three NLCD image views.

a Toggle through the different NLCD images to be sure that you have
captured your area of interest.

b You can remove individual pixels from the edges and interior of your area

of interest by clicking the TouchUpEraser button and then clicking on the
pixels to be removed.

c When you are satisfied, click Auto Clip. The NLCD image will appear
clipped to your new boundaries.
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d Then click Save and navigate to the folder where you want to save the

images. For each of the three images, edit the name as desired, and click
Save.

e Once you are finished, click OK in the Define AOI on NLCD Imagery
window and Vue processing will begin.

Usage note: Output processing time is system and project dependent. A message will
appear on the Vue welcome screen asking you to please wait while image statistics
are calculated. On slower machines, processing may take several minutes.

Understanding the Vue Layout
Main windows
The NLCD images appear in the upper left, upper right, and lower left corners of the
window. Each image can be maximized by clicking the Maximize square in its top right
corner. The lower right corner is reserved for the analysis outputs or can be used to dock
the Google Vue or Google Find windows. We’ll return to these features in just a minute.

Map controls
The map controls are found at the bottom left of the screen and allow you to change the
level of zoom, turn on and off the map legends, measure a straightline distance down
to the resolution of the data (~100 ft/30 m), and print the current view. Mouse over the
buttons to see what each does. Metric units can be displayed by selecting the Metric Units
button.

GoogleFind
GoogleFind lets you click a point on any of the four images to find that location on
Google Maps in a separate pop-up window. (An active, high-speed internet connection
and Javascript are needed.) The Google window can then be “docked” in one of the
four quadrants if desired by selecting UL, UR, LL, LR for upper and lower right or left
quadrants. Select Undock to return to center pop-up or “X” to close.
Once the GoogleFind button has been clicked it remains activated and will generate a
new map each time you click on a location until it is toggled off.

GoogleVue
GoogleVue allows you to view a translucent overlay of the NLCD imagery on top of Google
maps by clicking a point on any of the four images. Depending which of the NLCD images
you click on, an 11x11-pixel set of land, tree, impervious cover or analysis data will be
8

generated over the selected point. This feature allows you to view and compare NLCD
imagery with more recent Google map images. When GoogleVue is showing NLCD land
cover data, right-clicking on a pixel will display the NLCD class. When legends are turned
on in Vue, they will also appear in the GoogleVue map.
Once the GoogleVue option has been clicked it remains activated and will generate a
new overlay until the button is toggled off. The pop-up window can also be docked in any
quadrant using the tool bar above the GoogleVue image.

Tabs panel
Along the right side of the screen, tabbed pages of statistics are presented. The General
tab presents tree canopy and impervious cover (in acres and percent) across your
study area and for the general land cover categories. The next six tabs present a more
detailed look at the land cover types. The Pixel Info tab enables you to get a closer
look at the composition of individual 30 x 30 m pixels. If you move your mouse over one
of the images, the land cover, tree canopy, impervious cover and selected ecosystem
services provided by trees within that pixel will be presented. The Classes tab provides
a description of the NLCD land cover classes. The About tab includes links to several
documents to provide more information and the Help tab offers general instructions.
The tabbed reports can be viewed in printable form by clicking the notepad icon in the top
right corner.

Analysis Options
The Analysis Options drop-down list at the bottom right of the screen is the core of the Vue
program. It offers written reports and corresponding map images for a number of
ecosystem services and several options for exploring different planting scenarios. The
output reports begin with an initial window that offers different options or that allows you to
make adjustments based on locally available data. Once this has been completed or the
default options have been accepted, the output image will appear it the bottom right corner
of the main window and a written report will appear in a pop-up window in a “tree” or
outline form. Click the plus signs to open new levels or click Expand All to view all results
in a given report at once. The written report can also be accessed via the notepad icon in
the bottom right corner of the output window.
Usage note: For all of the analysis options, output processing time is system and
selection dependent. On slower machines, processing may take several minutes. The
output processing progress is shown by a progress bar at the bottom of the screen.
Occasionally, this progress bar will appear to stall due to other system activity on your
computer. You should NOT exit the program at this point. Instead, wait a few more
minutes for the processing to complete.
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NLCD tree and impervious cover adjustment analysis options
Before you get started with analysis, you might want to make some adjustments to the
inputs to account for recent research (2010) using photo interpretation that indicates that
NLCD underestimates tree canopy and/or impervious cover to various degrees across the
country.

1 From the Analysis Options drop-down menu, select NLCD Adjustment: Tree
Canopy. The NLCD Adjustment Factor Screen will appear.

2 Use the zoom and pan buttons on the tool bar to find the map region number
(1–65) that best represents your area of interest.

3 Scroll down in the chart below the map to find your zone and corresponding
regional adjustment factor in bold in the Difference column.

4 Double-click the appropriate difference and it will be entered in the box at the top of
the screen.

5 Click OK to process and a revised Tree Canopy map will appear.
6 Follow the same process to adjust for impervious cover, starting with Analysis
Options > NLCD Adjustment: Impervious Cover.

Adjusted tree and impervious cover images will be saved in the same directory with your
original imagery files and will have a suffix of _ADJ (adjustment value) attached to the
original file name.
A technical journal article describing the methodology for determining these values can be
accessed from the NLCD Adjustment Factor Screen by clicking the Adjustment Factor
Information button.

Ecosystem services
The first window that appears for each ecosystem service allows you to adjust the state
or national average data that Vue uses to calculate ecosystem services if desired. For
example, carbon storage on a per acre basis is estimated using a national average of 9.1
kg C/m2 or 81,188.3 lbs C/acre and a monetary value of $20.68/ton. If you have better
local information you can edit as desired.
In this window, simply make any adjustments you wish and click OK to begin processing.
There are seven ecosystem services reports that describe the estimated benefits of the
existing urban forest. Keep in mind that in each case, the results refer to the benefits
derived from the trees. So, for example, when carbon storage is reported for the
agricultural land cover class, this refers only to the carbon storage of trees within that land
cover class, not to the total carbon stored in soil, crops, etc.
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Carbon storage: The carbon storage output report estimates the total carbon (and
carbon dioxide equivalents) stored in the total urban forest. Results are also presented
for each land cover type.
Carbon sequestration: The carbon sequestration report estimates the annual carbon
(and carbon dioxide equivalents) sequestered each year by the urban forest. Results
are also presented for each land cover type.
CO pollution removal: The CO pollution removal report estimates the amount of
carbon monoxide removed by the urban forest annually. Results are also presented for
each land cover type.
NO2 pollution removal: The NO2 pollution removal report estimates the amount of
nitrogen dioxide removed by the urban forest annually. Results are also presented for
each land cover type.
O3 pollution removal: The O3 pollution removal report estimates the amount of ozone
(smog) removed by the urban forest annually. Results are also presented for each land
cover type.
SO2 pollution removal: The SO2 pollution removal report estimates the amount of
sulfur dioxide removed by the urban forest annually. Results are also presented for
each land cover type.
PM10 pollution removal: The PM10 pollution removal report estimates the amount
of small particulate matter removed by the urban forest annually. Results are also
presented for each land cover type.

Existing urban forest structure reports
For the reports on existing urban forest structure, the first window that appears allows
you to perform analyses for different land uses. Check and uncheck the boxes next to the
different land uses to select the ones to be analyzed. Click OK when you are finished to
begin processing.
There are two reports describing the existing urban forest structure.
Tree available growing space: The available space report estimates the amount
of available planting space as the total area minus existing canopy cover minus
impervious surface. Results are also presented for each land cover type and for the
total study area.
Tree canopy stocking: The canopy stocking report presents total tree canopy in acres
and percent for your study area. Results are also presented for each land cover type.

Tree canopy % change reports
The first window that appears for each of the tree canopy modeling reports allows you to
enter different levels of canopy cover and to adjust per-acre values and monetary values.
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In the window, enter a new value for canopy cover. Then, if you wish to edit the default per
acre or monetary values for any of the ecosystem services, check the box next to each
service. The appropriate fields will appear and can be edited.
There are four canopy cover modeling reports that allow you to explore the effects of
increasing or decreasing canopy cover.
The Region report adjusts canopy cover evenly across the study area.
The Developed, All report allows you to increase (or decrease) canopy cover equally
across developed areas while leaving canopy levels in other land cover types as they
are.
The Developed, Classes report allows you to target canopy cover changes to
developed areas of different intensities, considering for example that a very dense
urban core will have a lower canopy cover target than suburban areas.
The General Classes report allows you to target canopy cover changes across broad
land cover categories.

Printing and saving results
For written reports, the print and save options are available at the bottom of each report.
Clicking Print will print reports directly to your default printer in the state in which they
appear on the screen, i.e., where nodes are hidden, the results will not appear. The Save
option results in a comma-delimited text file.
To save the output image file and the corresponding NLCD images, click the Save Output
button at the bottom right of the main window. Navigate to the desired location, give the
file a name and click Save. A .tif file with the image and a .tfw worldfile for use in GIS
programs will be saved.
The four images can also be printed together as they appear in the current view with their
respective legends. Click the Print button at the bottom of the main screen for this option.
Then click the Print button on the Print Preview window that appears.
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Appendix: Limitation and Data Notes
Limitations
i-Tree Vue provides broad estimates of tree cover and some urban forest ecosystem
services without requiring the user to collect field data. As this program does not require
field data collection, the estimates can only be considered very coarse approximations
with some significant limitations on the data and estimates.
Despite these limitations, the i-Tree Vue is designed to provide easy first-order estimates
of ecosystem services for urban areas. These data be can used to view differences in
existing cover and services, potential changes in benefits with changes in tree cover, and
to provide a stepping stone to more accurate estimates of services through i-Tree Eco or
i-Tree Streets. These data should not be considered final or accurate estimates of urban
tree cover or environmental services.

Generalized estimates
The basic approach to i-Tree Vue is to use spatial tree cover maps developed by the
National Land Cover Database (NLCD) (http://www.mrlc.gov/) and apply average
ecosystem service values per unit of canopy cover to estimate services of the local area.
This generalized approach using national or state averages has significant limitations at
the local scale.

NLCD tree cover estimates
NLCD provides tree cover estimates within 30-meter pixel resolution for the contiguous
United States. This national database provides important information on our national tree
resources, but has limitations, particularly at the local scale. Tree cover estimates from the
NLCD cover maps have been shown to underestimate tree cover by an average of about
10% (Nowak and Greenfield 2010) across the nation and by as much as 28%. Similarly,
estimates of impervious surface have been shown to be underestimated by an average of
1.4% and by as much as 6%. Vue v. 4.0 offers new functionality that allows you to make
a coarse adjustment to the canopy cover of your area based on the work by Nowak and
Greenfield (2010).

Air pollution removal estimates
To more accurately estimate pollution removal in a city, local pollution and weather data
are needed, as well as local estimates of the leaf area index (depth of canopy) and canopy
cover. As local data are unknown in i-Tree Vue (except for the estimate of tree cover),
i-Tree Vue uses state average estimates of annual pollution removal per square meter
of tree cover (g/m2/yr) to estimate local pollution removal assuming a leaf area index of
6 [i.e., 6 m2 of leaves (one-sided) per m2 of canopy cover]. As pollution concentrations,
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weather, and urban forest leaf area indices can differ significantly at the local level, i-Tree
Vue estimates are coarse at best. The closer your area conditions are to the state average
and a leaf area index of 6, the closer the i-Tree Vue estimate will be for your area. Better
estimates can be obtained by collecting local field data and using i-Tree Eco or i-Tree
Streets. More information on how air pollution removal was calculated are given below.

Carbon storage and sequestration estimates
To more accurately estimate carbon storage (amount of carbon currently in trees) and
annual carbon sequestration (amount of carbon removed in one year) in a city, local
environmental conditions (e.g., tree competition, length of growing season) and tree
density, species, and diameter distribution information are required. As local tree data
are unknown in i-Tree Vue (except for the estimate of tree cover), i-Tree Vue uses
national average estimates to approximate local carbon effects. Carbon sequestration
and storage values are estimated from tree cover (m2) multiplied by average carbon
storage (9.1 kg C/m2), and sequestration (0.3 kg C/m2) density values derived from several
U.S. communities (e.g., Nowak and Crane 2002, Nowak and Greenfield 2008). As tree
population and environmental variables can differ significantly at the local level, i-Tree Vue
estimates are coarse at best. The closer your area conditions are to the group average,
the closer the i-Tree Vue estimate will be for your area. Better estimates can be obtained
by collecting local field data and using i-Tree Eco or i-Tree Streets.

Dollar value estimates
Monetary estimates of ecosystem services are based on literature estimates of values
per ton of pollution or carbon. Monetary values associated with urban tree carbon storage
and sequestration were based on the 2001–2010 projected marginal social cost of carbon
dioxide emissions, $22.8/t C (Fankhauser 1994). Pollution-removal dollar value estimates
were calculated using 1994 national median externality values used in energy decision
making (Murray et al. 1994, Ottinger et al. 1990). The 1994 values were adjusted to 2007
dollars based on the producer price index (U.S. Dept. of Labor 2008). These values, in
dollars/metric ton (t) are as follows: nitrogen dioxide (NO2) = $9,906/t, particulate matter
less than 10 microns (PM10) = $6,614/t, sulfur dioxide (SO2) = $2,425/t, carbon monoxide
(CO) = $1,407/t. Externality values for ozone (O3) were set to equal the value for NO2.
Externality values can be considered the estimated cost of pollution to society that is not
accounted for in the market price of the goods or services that produced the pollution.

NLCD Imagery Technical Notes
NLCD image data are stored as values from 0 to 100 in each image pixel. As such, results
of the new tree canopy estimates are necessarily rounded. This rounding has the potential
to skew user-defined tree cover estimates in the output tree canopy data set by up to one
percent. This skewing is more pronounced when dealing with a region or land use that
covers a very small area of interest. In addition, carbon and pollution values are not actually
stored in the image pixels as rounding them would reduce their usefulness. Instead, tree
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canopy—existing or new estimates—are stored in the image pixels. Within i-Tree Vue, the
carbon and pollution values are then computed on the fly for display in the pixel information
windows. After export of carbon or pollution images, you can multiply the stored tree canopy
values by your chosen carbon and pollution values in your GIS program.

Projection system
See www.mrlc.gov or the metadata files that came with the images for more information:
Projection ALBERS
Datum NAD83
Spheroid GRS80
Units METERS
Zunits NO
Xshift 0.0
Yshift 0.0
Parameters
29 30 0.0 /* 1st standard parallel
45 30 0.0 /* 2nd standard parallel
-96 0 0.0 /* central meridian
23 0 0.0 /* latitude of projection’s origin
0.0 /* false easting (meters)
0.0 /* false northing (meters)

Air Pollution Removal Methods
Air pollution removal estimates are derived from the Urban Forest Effects (UFORE) model
(Nowak and Crane 2000) and 2000 weather and pollution data (National Climatic Data
Center 2000, U.S. EPA 2008). The UFORE model was used to integrate hourly pollution
and weather data with urban or community tree cover data to estimate annual pollution
removal in each state (Nowak and Crane 2000, Nowak et al. 2006).
To estimate pollution by urban trees in each state, state pollutant flux rates (grams of
pollution removal per square meter of canopy per year) were derived from a study of
national pollution removal by urban trees for the year 1994 (Nowak et al. 2006). As
pollution concentrations vary through time, the 1994 flux rates were adjusted to 2000
values based on average regional pollution concentration changes between 1994 and
2000 (U.S. EPA 2003). As flux rate = deposition velocity * pollution concentration, the ratio
of the pollution concentration between years was used to update the flux rate.
Arithmetic mean concentration values were used for nitrogen dioxide, particulate matter
less than 10 microns, and sulfur dioxide; 2nd max. 8-hr average for carbon dioxide; and
4th max. 8-hr average for ozone, to determine the ratio of change between 1994 and 2000
(U.S. EPA 2003). The new 2000 flux rates are multiplied by urban or community tree cover
to estimate total pollution removal by trees.
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